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1. Programme Description 

1.1. General 
The programme com2ips operates as an interface between a device soft-
ware and (measuring) devices within a network and / or (measuring) de-
vices connected to any number of COM ports of the PC on which 
com2ips is running.  

1.2. com2ips Light  
Use com2ips Light to address any device with a serial interface via your 
corporate network or via the internet. In order to do this, connect the de-
vice to a COM port of your PC. Start com2ips, set the COM port and start 
the data transfer. You can now access the device activated via com2ips 
from any computer within your corporate network. It works the same way 
via internet if you start com2ips on your internet server. 

com2ips can be started several times on one computer, thus activating 
several devices with a serial interface at the same time.  

 

1.3. com2ips Standard  
If your device with a serial interface supports a bus protocol, you can use 
com2ips to connect several devices via your network. Instead of doing 
this by installing a costly new RS485 cable, you can simply use your ex-
isting network. com2ips will use the network in order to realize a “virtual” 
RS485 connection between your devices via the network.  

2. Installation and Programme 
Start 

2.1. Installation 
Installation is perfectly simple: start the file Setup.exe and follow the in-
structions of the installation routine.  
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2.2. Programme Start 
The programme group “com2ips“ will be entered into your start menu dur-
ing installation. Start your programme from this group.  

2.3. Test Operation 
If you are working with the test version of com2ips, the dialogue “License 
Information” will appear after starting the programme.  

In this dialogue you are informed about the remaining time during which 
the test version of the programme can be run and how to register the 
software.  

Other than that, the test version of the programme is exactly the same as 
the full version, only that it is limited for operation on your computer.  

2.3.1. The Dialogue “License Information“ 
The dialogue “License Information” will appear: 
⋅ when the programme is started, if you are working with a test ver-

sion of com2ips; 
⋅ when clicking on the button License in the dialogue “Info on 

com2ips“ (only in the test and the Light version) 

In this dialogue you are informed about the remaining time during which 
the test version of the programme can be run and how to register the 
software or how to upgrade to the standard version.  

3. Operation 

3.1. Brief Instruction 

3.1.1. First Steps 
The preparation of com2ips for the desired redirection / distribution of the 
data flow is carried out in the following steps: 
⋅ Programme start 
⋅ Check / change host settings 
⋅ Create new connection; check / change settings 
⋅ Start data transfer  

Now enter the host settings as output interface into the device software 
and start data transfer.  
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Example 1 is the redirection from a TCP connection as host to a COM 
port, example 2 is the redirection from a COM port as host to a TCP con-
nection.  

3.1.2. Redirection from a TCP connection to a COM port 
A redirection from a TCP connection to a COM port may be required if a 
(measuring) device is connected to a PC in the network and is to be ad-
dressed by any other PC in the network. In this case, the software 
com2ips must be installed on the PC to which the (measuring) device is 
connected. Then carry out the following steps: 

Programme Start  
 

 
When starting the application, a connection table will appear in the main 
window. This table contains either the connection entries that were active 
when the programme was last shut down, or (when starting the pro-
gramme for the first time) only the entry for the host. In this case, the 
programme will enter a TCP connection as host, with the default port 
8000. The IP address is automatically the address of the computer from 
which com2ips has been started.  

Check / Change Host Settings 

  
In order to change the number of the TCP port, select the menu function 
Settings/ Connection Settings. The host connection can be changed in 
the respective entry field in the dialogue “Host Connection”.  

Create New Connection; Check / Change Settings  
 

 
A COM port for redirection of the data flow can be determined via the 
menu function Edit/New Connection/COM Port Connection. When calling 
this function, the dialogue “COM Settings” will appear. A text for the de-
scription of the connection can be entered into the field “Name of Con-
nection”. 
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The COM port is selected from the list which opens by clicking, with the 
left mouse button, on the button right from the display field. The COM 
port settings can be changed in the dialogue “COM Port Details”. This 
dialogue is opened via the button COM Port Details. 

 

 
 

Start of Data Transfer 
Data transfer with com2ips is started via the menu function Settings/Data 
Transfer. The software will search the chosen ports in the system and 
wait for the arrival of the data via the port that has been selected as host. 
Once the data have arrived (after starting the device software), they are 
forwarded to the connection port(s), and the replies are returned to the 
host port.  

3.1.3. Redirection from a COM port to a TCP connection  
A redirection from a COM port to a TCP connection may be required if a 
(measuring) device is connected to the network via a hardware converter 
and can thus be addressed via an IP address and a TCP port, but the 
device software does not support direct access via an Ethernet interface 
(indication of IP address and TCP port). In that case, the software 
com2ips must be installed on the PC on which the device software is 
running. Then carry out the following steps: 

Programme Start  
 
 

When starting the application, a connection table will appear in the main 
window. This table contains either the connection entries that were active 
when the programme was last shut down, or (when starting the pro-
gramme for the first time) only the entry for the host.  
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In this case, the programme will enter a TCP connection as host, with the 
default port 8000. The IP address is automatically the address of the 
computer from which com2ips has been started.  

Check / Change Host Settings  
 

 
Either a TCP port (default) or a COM port can serve as host. In order to 
determine a COM port as host, select the menu function Set-
tings/Connection Settings. 

In the dialogue “Host Connection“, click once, with the left mouse button, 
onto the option field “COM Port” in order to determine that a COM port is 
to serve as host.  

The COM port is selected from the list which opens by clicking, with the 
left mouse button, on the button right from the display field. The COM 
port settings can be changed in the dialogue “COM Port Details”. This 
dialogue is opened via the button COM Port Details. 

 

Warning! 

A “COM redirection” is required in order to be able to address the COM 
port selected as host from your device software. It will direct the data flow 
from the output port of the device software to the input port (host) of 
com2ips. If you are not in possession of the corresponding software, 
connect the output COM port of your device software to the host COM 
port of com2ips with a nullmodem cable.  

Create New Connection; Check / Change Settings 
 

 
A TCP connection for redirection of the data flow can be determined via 
the menu function Edit/New Connection/TCP Connection. When calling 
this function, the dialogue “TCP/IP Settings” will appear. A text for the 
description of the connection can be entered into the field “Name of Con-
nection”. The IP address and the TCP port are to be entered into the re-
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spective entry fields. Make sure these values correspond to those of the 
hardware converter in use.  

Start of Data Transfer 
Data transfer with com2ips is started via the menu function Settings/Data 
Transfer. The software will search the selected ports in the system and 
wait for the arrival of the data via the port that has been selected as host. 
Once the data have arrived (after starting the device software), they are 
forwarded to the connection port(s), and the replies are returned to the 
host port. 

 

3.1.4. Programme Start via Command Line  
Com2ips can be started by calling a command line, too. Several parame-
ters can be given. It is thus possible, for example, to organize an auto-
matic programme start with direct data transfer.  

 

The following parameters are possible: 
⋅ connect – for immediate commencement of data transfer after 

programme start  
⋅ nosplash – for suppressing the display of the opening picture dur-

ing programme start  
⋅ filename.ini – for starting the programme with a special configura-

tion (file)  

If, for example, com2ips shall be started with the configuration 1 (saved 
in the file configuration1.ini), data transfer shall begin immediately and 
the opening picture shall not be displayed, the call takes the following 
form: “com2ips configuration1.ini – connect – nosplash”. If the name of 
the configuration file contains blanks, it is to be put into inverted commas.  

 

3.2. Main Window 

3.2.1. Connection Table 
The main window contains the connection table, in which all connections 
which have been agreed are listed. Each connection contains the ele-
ments “Name”, “Address”, “Connection”, “Transfer” and “Last Message”. 
The port serving as host is always described in the first line.  

The dialogue “Table Settings“ is opened via the command View/Table or 
Properties/Table Settings. You can determine in this dialogue which in-
formation (column) of the table is to be displayed.  

Warning! 

The host name cannot be changed. If a TCP connection has been de-
termined as host, it will automatically be given the IP address of the com-
puter on which com2ips is running. In this case only the TCP port ap-
pears as address.  
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3.2.2. Menu Bar 
The menu bar consists of five main menus: 

 

File 

This menu contains the functions for saving and loading configuration 
files, for printing the connection table and for exiting the programme.  

Edit 

You can make new connections via this menu and delete existing con-
nections (entries). Furthermore, table entries can be copied into tempo-
rary memory.  

View 
Change the appearance of the main window and the table settings in this 
menu.  

 

Settings 
This menu features the function Start / Stop of data transfer. Further-
more, the properties of existing connections and of the table can be 
changed.  

Help 

The menu item “Help Topics“ starts the help function integrated into the 
programme, the menu item “Info” displays an information window with 
version number, operating system and copyright information.   

3.2.3. Symbol Bar, Status Bar 

 
The symbol bar contains buttons for frequently used functions and thus 
enables fast access to these functions. The symbol bar can be turned on 
or off via the command View/Symbol Bar. 

 
The status bar gives brief information on the functions currently active in 
the menu or in the symbol bar and on the status of data transfer. The 
status bar can be turned on or off via the command View/Status Bar. The 
width of the status bar depends on the width of the display. If it is too nar-
row, not all information may be displayed.  
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3.3. The File Menu 

3.3.1. Load  Configuration 
If a configuration (connections), once created, has been saved in a file 
via the command File/Save Configuration, the settings can be loaded via 
File/Load Configuration. In case of identical terminal assignment of ports, 
the system communication can take place at once in the desired way, 
without having to recover the settings manually.  

The requested file is selected from the standard file dialogue according to 
file name, file type, drive and directory.  

3.3.2. Save  Configuration 
Once created, any connection can be saved in a file via the command 
File/Save Configuration. On request, this configuration can be loaded via 
File/Load Configuration. In case of identical terminal assignment of ports, 
the system communication can take place at once in the desired way, 
without having to recover the settings manually.  

The requested file is selected from the standard file dialogue according to 
file name, file type, drive and directory. 

3.3.3. Print 
The command File/Print controls the printing process for printing the con-
nection table. Before executing this command, a Windows printer has to 
be installed and, unless installed as standard printer, it must be selected 
by the programme. Please refer to your Windows Documentation for in-
formation on printer installation. Please refer to “Printer Setup” for further 
information on printer selection.  

 

3.3.4. Print Preview 
The command File/Print Preview shows what the printout of the connec-
tion table will look like. Click on the button Close to return to the pro-
gramme view, click on Print to start printing.  

3.3.5. Printer Setup 
This command shows you a list of all printers installed in your system. In 
the dialogue “Printer Setup”, you can select a special printer as default 
printer as well as further printing options for the printer you have se-
lected. Please refer to your Windows Documentation and your Printer 
Manual for further information on printer setup.  

3.3.6. Previous Files 
Use the numbers and names in the lower part of the file menu for speedy 
access to one of the files (configurations) which you have last worked 
with. Select the number or name of the requested file.  
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3.3.7. Exit 
With the command File/Exit, you leave the application and the pro-
gramme is shut down. Should data transfer be active at that time, you will 
be asked whether you really want to end the transfer.  

3.4. The Edit Menu 

3.4.1. New Connection 
Use the menu function Edit/New Connection to either set a COM port 
connection or a new TCP connection for transferring the data flow.  

New  COM port connection  
When calling the function Edit/New Connection/COM Port Connection, 
the dialogue “COM Settings” will appear. Enter a text for the description 
of the connection into the entry field “Name of Connection”. The COM 
port is selected from the list which can be opened with a click of the left 
mouse button onto the button right from the display field. The COM port 
settings can be changed in the dialogue “COM port details”. This dia-
logue is opened via the button COM Port Details. 

New TCP connection  

The dialogue “TCP/IP Settings“ will appear when calling the function 
Edit/New Connection/TCP Connection. Enter a text for the description of 
the connection into the entry field “Name of Connection”. The IP address 
and the TCP port are to be entered into the corresponding entry fields. 
These values must correspond to those of the respective counterpart 
(hardware converter or PC with com2ips).  

3.4.2. Delete Connection(s) 
If an element of an entry, the entire entry or several entries have been 
selected in the connection table, the function Edit/Delete Connection(s) 
can be applied to these. Calling this function will e.g. delete all entries 
from the table. 

The command Edit/Delete Connection(s) is not available for the host en-
try.  

The same function can be called via the button “Delete Connection(s)” in 
the symbol bar.  

3.4.3. Copy 
The command Edit/Copy is used to copy the contents of the selected ta-
ble elements into temporary memory. The copied contents can be copied 
into another programme via the command Edit/Paste. 

The same function can be called via the button “Copy” in the symbol bar.  
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3.5. The View Menu 

3.5.1. Symbol Bar and Status Bar 
The respective element from the main window can be displayed on 
screen or hidden via the command View/Symbol Bar and View/Status 
Bar. 

3.5.2. Table 
The dialogue “Table Settings“ is opened via the command View/Table. 
You can determine in this dialogue which information (column) is to be 
displayed in the table. In order to select or unselect an element, click with 
your left mouse button into the option field left from the corresponding 
text and confirm your settings with OK. 

This dialogue can also be called via the button “Table Settings“ in the 
symbol bar and via the command Settings/Table Settings. 

3.6. The Settings Menu 
 

3.6.1. Data Transfer 
Data transfer of com2ips is started and stopped via the command Set-
tings/Data Transfer. 

The same function can be called via the button “Start/Stop Data Transfer” 
in the symbol bar.  

3.6.2. Connection Settings 
The function Settings/Connection Settings can only be called if an entry 
in the connection table has been selected.  

In order to select the requested connection, move the mouse pointer into 
the first column of the table. The pointer symbol will change as soon as it 
is on the numbered elements of the entries. By a click with the left mouse 
button, the respective entry is selected.  

Depending on the connection type for which the function is called, either 
the dialogue “Host Connection”, the dialogue “TCP/IP Settings” or the 
dialogue “COM Settings” will appear.  

The corresponding dialogue can also be called via the button “Connec-
tion Settings“ in the symbol bar.  

Dialogue “Host Connection“  
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The port number for a TCP connection can be set in the dialogue “Host 
Connection”.  

By a single click into the option field “COM Port”, with the left mouse but-
ton, you can determine that a COM port is to serve as host. All elements 
for COM port selection and fixing of details are now active.  

The COM port is selected from the list which will be displayed after a sin-
gle mouse click (left button) onto the button right from the display field. 
The COM port settings can be changed in the dialogue “COM Port De-
tails”, which is opened via the button COM-Port Details. 

Dialogue “TCP/IP Settings“ 
 

 
A text for the description of the connection can be entered into the entry 
field “Name of Connection” in the dialogue “TCP/IP Settings”. The IP ad-
dress and the TCP port are to be entered into the respective entry fields. 
Make sure these values correspond to those of the counterpart (hard-
ware converter or PC with com2ips) in use. 

Dialogue “COM Settings“ 
 

 
In the dialogue “COM Settings”, the COM port is selected from the list 
which will be displayed after a single mouse click (left button) onto the 
button right from the display field. The COM port settings can be changed 
in the dialogue “COM Port Details”, which is opened via the button COM-
Port Details. 

Dialogue “COM Port Details“  
 

The dialogue “COM-Port Details“ is used to make settings for baud rate, 
number of data bits and stop bits, parity and handshake.  
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Please refer to your device documentation for information on required 
settings.  

3.6.3. Table Settings 
The dialogue “Table Settings“ is opened via the command Settings/Table 
Settings.  

 
 

You can determine in this dialogue which information (column) is to be 
displayed in the table. In order to select or unselect an element, click into 
the option field left from the corresponding text with the left mouse button 
and confirm your settings with OK. 

This dialogue can also be called via the button “Table Settings“ in the 
symbol bar and via the function View/Table. 

3.7. The Help Menu 
The command Help/Help Topics shows a dialogue with the contents of 
the com2ips help system. The requested description can be shown via 
the table of contents, an index or a browse function.  
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4. Appendix 

4.1. Application Examples  

4.1.1. com2ips Light 

Access to a measuring device from several computers 
You have a measuring device with a serial interface (e.g. an Ahlborn 
ALMEMO device) connected to one of your PCs and would like to enable 
several of your employees to access this device from the network. First, 
start com2ips on your PC. If your software supports addressing the 
measuring devices via a TCP/IP connection (e.g. COM WinControl with 
the corresponding option), your staff can, at any time, access the meas-
uring device from the network.  

Remote Diagnosis 

A device with a serial interface does not operate as requested. The local 
staff is not able to solve the problem. Instead of making your way to the 
defective device, you can simply use the internet for access to the de-
vice. com2ips will assist you: 

Connect the device to the serial interface of a PC with internet access. A 
simple dial-up connection to any internet service provider will do the job. 
Then start com2ips on that PC. The operator will inform you of the IP ad-
dress of the PC. 

Now you can access the device from your PC, via the internet, and solve 
the problem! 

4.1.2. com2ips Standard 

Access to several measuring devices in one company  

You would like to monitor the temperature in three rooms. The monitoring 
computer is located in one of these rooms. First of all, connect an Ahl-
born ALMEMO measuring device with temperature sensor to the monitor-
ing PC. Another PC is already located in the second room that is to be 
monitored. Connect another ALMEMO measuring device to this PC. 

Next, start com2ips on the second PC in order to enable access to this 
measuring device from the network. Unfortunately, the third room is not 
equipped with a PC. Therefore, you install a hardware converter in this 
room, e.g. a Wiesemann & Theis Com Server, an ACOLA CoBox or a 
Digi PortServer. Back at the monitoring computer, start com2ips and en-
ter the addresses of the three ALMEMO measuring devices: the COM 
port for the local device, the IP address for the computer in the second 
room as well as the IP address of the converter in the third room. You 
can now start COM WinControl on the capturing computer and build up a 
connection to com2ips, which is running on the same computer. You are 
now able to operate with all three measurement devices as if they were 
locally connected to the capturing computer! 
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Time Control in Branches 

You would like to implement an electronic staff time control system in 
your company. Besides the head office, your company has two branches 
connected to the main location via a permanent line. The time control is 
to take place at head office.  

The time control system consists of a PC software solution as well as a 
number of access terminals. The terminals are usually connected to the 
PC via an RS 485 line.  

Here is one solution: the access terminals are connected to the corporate 
network with the help of hardware converters (e.g. Wiesemann & Theis 
Com Server, ACOLA CoBox or Digi PortServer). Since the time control 
system software only supports one single terminal connection, make use 
of com2ips to join the respective terminals into one unit.  

 

4.1.3. About 
com2ips Version 2.1 

Copyright© 1999-2003 akrobit® software GmbH 

akrobit® software GmbH  Fon: +49 365 420 9657 
Joh.-R.-Becher-Str. 64  Fax: +49 365 43 86 41 
D - 07546 Gera   www.akrobit.de 
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5. Glossary 

Serial Number 
In the dialog "COM WinControl License Information" in this field the serial 
number is shown. Please refer this number for registering software. 

Max Evaluation Time 
In the dialog "COM WinControl License Information" in this field the max 
evaluation time is shown.  

Remaining Evaluation Time 
In the dialog "COM WinControl License Information" in this field the re-
maining evaluation time is shown.  

Unlock Code 
Enter in the dialog "COM WinControl License Information" in this field the 
unlock code. Register the software, to get the unlock code. 

Calculation Channels 
Using the formula editor, you can define the settings for a calculation 
channel.  The polled data can be calculated and displayed both on and 
offline.  A calculation channel can be defined as global (that is it is avail-
able to the whole system) or as local (where it is only available in a cer-
tain diagram or table). 

 

The “License“ Button 
Click with the left mouse button on the License button in the “Info“ dia-
logue to open the dialogue "Com2ips License Information". This dialogue 
provides you with information on your license and on registration of the 
software.  

Baud Rate Selection 
Select the baud rate for operation of the serial connection in the dialogue  
“COM Port Details“.  

Data Bits Selection  
Select the number of bits for data transfer from the list in the dialogue 
“COM-Port Details“. 

Parity Selection 
Select the parity for data transfer from the list in the dialogue “COM-Port 
Details“. 
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Stop Bits Selection 
Select the number of stop bits for data transfer from the list in the dia-
logue “COM-Port Details“. 

Handshake Selection 
Select the protocol for the serial connection from the list in the dialogue 
“COM-Port Details“. 

Entry Field “Name of Connection“ 
Enter the requested name of the connection into the entry field in the dia-
logue “TCP/IP Settings or the dialogue “COM Settings“. 

Entry Field IP Address 
Enter the IP address for the TCP connection into the entry field in the dia-
logue “TCP/IP Settings“. 

COM Port Details Button 
In the dialogue „“Host Connections” or the dialogue “COM Settings”, click 
with the left mouse button onto the button COM Port Details to open the 
dialogue “COM Port Details” and to change the COM port settings.  

List of COM Ports 
Select COM ports from the list in the dialogue “Host Connection” or in the 
dialogue “COM Settings”. Click once, with the left mouse button, on the 
button right from the display field to show the list.  

Option Field “COM-Port“ 
Click once, with the left mouse button, onto the option field “COM Port” 
within the dialogue “Host Connection”  to determine that a COM port is to 
serve as host. Now the elements for selection of a COM port and fixing of 
details are active.  

Entry Field “TCP Port Number“ 
Enter the port number via which com2ips is to be addressed into the en-
try field in the dialogue “Host Connection“. 

Option Field “TCP-Port“ 
Click once, with the left mouse button, onto the option field “TCP Port” 
within the dialogue “Host Connection”  to determine that a TCP port is to 
serve as host. Now the entry field for selection of a TCP port is active 

Name of Connection 
The “Name“ in the connection table is the text which describes the con-
nection in the respective properties dialogue. Click, with the left mouse 
button, into the option field left from the text in order to display or hide the 
column in the connection table.  

Address of the Connection 
In the connection table, you can see under “Address” the IP address and 
the TCP port in case of a TCP connection and the COM port and the 
baud rate for a COM port connection. Click, with the left mouse button, 
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into the option field left from the text in order to display or hide the column 
in the connection table. 

State of the Connection 
In the connection table, you can see under “Connection” the current state 
of the respective connection. The possibilities for a host are “none”, “wait-
ing” and “connected”, for all other types of connection “none”, “making 
connection” and “connected”. Click, with the left mouse button, into the 
option field left from the text in order to display or hide the column in the 
connection table. 

Transfer 
In the connection table, you can see under “Transfer“ the data transfer, 
displayed by two symbols. The red arrow stands for data going out from 
com2ips, the green arrow stands for data coming in. Click, with the left 
mouse button, into the option field left from the text in order to display or 
hide the column in the connection table. 

Last Message 
In the connection table, you might see under “Last Message“ a text de-
scribing an error or its current status. This message will remain in the ta-
ble as long as it has been replaced by a new message or deleted by 
stopping and restarting the data transfer. Click, with the left mouse but-
ton, into the option field left from the text in order to display or hide the 
column in the connection table. 


